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Thank you for purchasing our product. If there is any question or request, please do not hesitate to
contact the dealer.

This manual applies to VMS-A1.

This manual may contain several technically inaccurate points or printing errors, and the content is
subject to change without notice. The updates will be added into the new version of this manual. We

will readily improve or update the products or procedures described in the manual.
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1. Overview

This guide provides only brief instructions on the installation, uninstallation, and some basic
operations such as the live view, record and playback of VMS-A1. For detailed information of how to
use the software, please refer to the User Manual of VMS-A1 V2.0.0.

2. System Requirements

Operating System: Microsoft Windows XP / Windows 2003 32-bit, Windows 7 / Windows 2008 32-bit
or 64-bit

CPU: Intel Pentium IV @ 3.00 GHz or above

Memory: 1G or above

Display: 1024*768 resolution or above

Note: For high stability and good performance, these above system requirements must be met.

3. Deployment Schemes

VMS-A1 can be used in the local area network (LAN) and the wide area network (WAN). In this
document, only some of the connection deployment schemes are displayed.
Note: In the real situation, the devices connected, such as the DVRs, NVRs, network cameras, etc., are

scalable.

3.1 In the Local Area Network

3.1.1 A Simplified Scheme in LAN
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Application Scenario:

1. Only one or a small quantity of clients need to get video stream from the devices.
2. The client and devices are in the same local subnet.

Hardware Required:

1. Network cameras, DVRs, etc.

2. PCinstalled with VMS-A1 client.

3. Switch or router.

This deployment scheme is convenient and cost-effective. Only the VMS-A1 client software is required

and you can get direct access to the connected devices, such as the network cameras, DVRs, etc.

3.1.2 A Complete Scheme in LAN
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Application Scenario:

1. Multiple clients need to get video stream from the devices.

2. There is no hard disk on the device side or there are disks on the device side, but the record files
need to be backed up for extra insurance.

Hardware Required:

1. Network cameras, DVRs, etc.

2. PCsinstalled with VMS-A1 client, VMS-A1 PCNVR, Stream Media Server and Storage Server.

3. Switch or router.

The DVR, HDVR, NVR, VMS-A1 PCNVR can connect to and manage the cameras, speed domes, video
encoders, etc., and the VMS-A1 client can be used to manage the DVR, HDVR, NVR, PCNVR which
provide relatively complete function of the management.

The stream media server can be adopted to forward the video stream so as to lower the network load
of the devices. The record files can be stored on the HDDs of the local device, or on the remote
storage server. You can also access the client through the web browsing and do some basic operations,

including live view, playback, etc.
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3.2 In the Wide Area Network

3.2.1 Statistic IP in WAN
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Application Scenario:
1. The devices need to be accessed in WAN.
2. Statistic IP addresses are assigned to the connected devices in WAN.
Hardware Required:
1. Network cameras, DVRs, etc.
2. PCsinstalled with VMS-A1 client, VMS-A1 PCNVR, Stream Media Server and Storage Server.
3. Switch or router.

Statistic IP address can be assigned to the device in WAN and the VMS-A1 client can access the device
directly through the IP address. It is costly when there are multiple devices connected.

You can adopt the router to connect to the Internet, assign a statistic IP address to the router, and
then get access to the devices through the router IP address and port number.
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3.2.2 Dynamic IP in WAN
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Application Scenario:

1. The devices need to be accessed in WAN.

2. The devices can be accessed through device domain names (registered on DNS Server) in WAN.
Hardware Required:

1. Network cameras, DVRs, etc.

2. PCsinstalled with VMS-A1 client, VMS-A1 PCNVR, Stream Media Server and Storage Server.

3. Switch or router.

You can register domain names for the devices on the DNS server, such as Peanuthull, DynDNS,
HiDDNS, etc., and then get access to the devices through the device domain names.

When there are multiple devices connected to the Internet via the router, you can configure domain
name on the router, and then get access to the devices through the router domain name and port
number, thus to reduce the cost of the domain name.
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4. Installation and Uninstallation

4.1 Installation
Insert the installation media into the appropriate computer.
Perform the following steps to install the VMS-A1 client software.

1. Double-click the program file VMS-Al.exe {5 enter the welcome panel of the InstallShield

Wizard. Click Next to start the InstallShield Wizard.

Welcome to the InstallShield Wizard for VM5-A1

The InstallShigld \wizard will install Y4541 an wour
computer. To continue, click Mest.

2. On the next panel, you are prompted to select the function module to install.

(MS-A1 - InstaliShield W x|

Select Features

Select the features setup will install

Select the features you want to install, and deselect the features you do not wart to install

Client
] Starage Server
] Stream Media Server

Destination Falder

C:\Program Files\WMS-41 StationwhS-41
Space Required on C: 158080 K

Space Avaiable on C: 58895280 K.

|nztallShield

< Back l[ Mext » ][ Caticel ]

Storage Server: The storage server performs as a NVR installed on the PC and the record files can
be stored on the storage server.
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Stream Media Server: The video stream can be forwarded through the stream media server, thus

to lower the load of the device.

Set installation directory where the client software is to be installed. You can either accept the
default directory that is displayed, or click Browse and select a different directory.

You can also click Disk Space to choose the disk drive to install the software, and check the space
information of the disk on the panel.

Note: The default directory is C:\Program Files\VMS-A1 Station\VMS-A1.

Click Next to continue.
3. Install the WinpCap plug-in according to the prompts to detect the online devices when running
the client software.

= ———
WVMS-AT - InstallShield Wizar X

Install the third-party plug-in.

Check the checkbos for installing the plug-in; if the checkbox is not
checked, the plug-in will not be installed.

“wWinpCap

Finding the active on-ine devices when run the client software. Wersion:4.1.1

<Back [ Meut: |[ Cancel

4. Read the pre-install information and click Install to begin the installation.

MS-A1 - Instz

Ready to Install the Program

The wizard iz ready to begin installation.

Click. Install ta begin the installation.

I piour want to review or change any of wour installation zettings, click Back. Click Cancel to exit
the wizard.

<Back [ Instal |[ Cancel

5. A panel indicating progress of the installation is displayed. A percentage completion bar is
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updated as the installation progresses.

Setup Status

The InstallShield Wizard iz installing Wk 5-A1

Inztalling

Coh SWMS-8T StationhyiS-4715WMS-A1 Clent\CommLibClt.dil

IrztallShield

Caticel

6. Select the setup type according to your need.
You can check the checkbox Create Desktop for Client to create a shortcut icon on the desktop for
the client software.
[VMS-AL - InstallShicld Wizare

Setup Type
Select the setup tupe that best suits your needs.

Select the features you want ta inzstall, and deselect the features pou do not want ta install
Click Mest to cantinue.

Create Desktop for Client

[F]iCreate Desktop for Storage Serves
Create Desktop for Stream Media Server

InztallShield

< Back Caticel

7. Read the post-install information and click Finish.
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InstallShield Wizard Complete

The InstallShield Wizard has successfully installed WM5-41.
Click. Finish to exit the wizard.

4.2 Uninstallation

Double-click the program file E¥ ivMs-4200(+2.00) again, select Remove, click Next and click Yes to
uninstall the VMS-A1 according to the prompts.

‘Welcome

radify, repair, or remove the program.

Welcome to the WMS-41 Setup Maintenance program. Thiz program lets you modify the current
ingtallation. Click one of the options below.

VMS-AL - InstallShield Wizard

Remaowve all installed features.

InztallShield

< Back k Mext =
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5. Quick Start

5.1 User Registration and Login

For the first time to use VMS-A1 client software, you need to register a super user for login.
Steps:

1. Input the super user name and password.

2. Confirm the password.

3. Optionally, check the checkbox Enable Auto-login to log in the software automatically.
4

Click Register. Then, you can log in the software as the super user.

Register Administrator x

Please create a super user before ceeding

Super User T |
Passward:
Confirm Password:

Enable Auto-login

Register Cancel

Notes:
® Auser name cannot contain any of the following characters: /\: * ? “ <> |
® The password cannot be empty and the length of the password should be no less than six

characters.

When opening VMS-A1 after registration, you can log in the client software with the registered user
name and password.

Steps:

1. Input the user name and password you registered.

2. Optionally, check the checkbox Enable Auto-login to log in the software automatically.

3. Click Login.

Name: admin | i

Passwaord:

Enable auto-login

Login Cancel

10
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5.2 Wizard for Importing Device

You enter the wizard interface of VMS-A1 after login. This wizard helps you to go through the basic

operations of the client software, such as adding devices, importing devices into groups, configuring

record schedule, etc. You can also have a quick look at some features of the latest software, including

view operation, camera linkage and web access.

Perform the following steps to go through the wizard and study the operations provided.

Step 1: Start Guide

When there is no device added to VMS-A1, the wizard for importing devices will show up after you log

in the software. You can also open the wizard from the Help menu.

[ 1-Screen

L -Screen

4 o-screen

& 15-80een

+ W Custom View

View Operation
Support view operation when previewing
or playback

Management of cameras is more diverse

P

Gonfigura Device and Recora Schadule Closed

Click Configure Device and Record Schedule to start the guide.

You can also click Closed to exit the wizard.

Step 2: Adding Devices

Devices including network cameras, video encoders, DVRs, NVRs, should be added to the client for the

remote configuration and management, such as live view, playback, alarm settings, etc.

11
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Desics Hanagsment Group Wanagsment Recorg Scheule
Organization Device for Management (0}
I o Vodt Defete Remate Conf Refrash Al Finer
Nickname  ~ 1P Device Serial Mo Resource Usa... HDD Stalus | Recar
Online Device (4} Refresh Every 155
4 AddtoClent - AddAl  ModiyNetinfa  Restore Defaukt Password Fiter
13 - Device Type Port Device Serial No. hdded
1921681134 INVR-04A 8000 INVR-D4AD4201H30BERRAISHIHTWEV o | |
Encoding device can be added -
DVRDVARVRIPCAPDAMS41 1821681115 IDH3IR 8000 IDH-31IRD120130822CCRRA31080285 Ho
PCNVRAMS-A1 Encoding 5
b 192158112 IMH-21 8000 IMH-2101201308098BRR420841252 No
HomePage Next Finished

You can add the device in the following ways:

Adding Online Devices.
Adding Devices Manually.
Adding Devices by IP Segment.
Adding Devices by IP Server.
Adding Devices by HiDDNS.

Adding Online Devices
The active online devices in the same local subnet with the client software will be displayed on a list.

You can click the Refresh Every 15s button to refresh the information of the online devices.

Steps:
1. Select the devices to be added from the list.
2. Click Add to Client to open the device adding dialog box.
3. Input the required information.
Nickname: Edit a name for the device as you want.
Address: Input the device’s IP address. The IP address of the device is obtained automatically in
this adding mode.
Port: Input the device port number. The default value is 8000.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
the channels of the device will be imported to the corresponding group by default.
5. Click Add to add the device.

12
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Add x

Adding Mode:

@ IPIDomain IP Segment . IP Semnver . HiDDNS

Add Offline Device

Mickname:

Address

Port: 8000
Name admin
Password: COCC

+/ Exportto group

Setthe device name as the group name and add all the channels
connected to the device to the group.

Click Add All, input the device user name and password, and you can add all the online devices to the

client software.

Adding Mode:

@ IP/Domain IP Segment IP Server HIDDNS

MName:

Password:
+ Exportto group
Create group with device IP.

Select the device from the list, click Modify Netinfo, input the device password, and then you can

modify the network information of the selected device, including the IP address, port, gateway, etc.

Modify the Selected Device x

Device Information:

WMAC Address: 8c-e7-48-3c-df-70 Copy
Software Version W2.3.4build 130731 Copy
Device Serial No.: INVR-04A0420131030BBRR439113117WCYU Copy

Network Information

IP address 192168.11.34
Port 8000

Subnet Mask: 255 255 2550
Gateway: 192.168.11.1

Manager Password:

13
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Select the device from the list, click Restore Default Password, input the security code, and then you
can restore the default password of the selected device.
Modify the Selected Device
Restore Default Password:

Password:

For details of other device adding methods, please refer to the User Manual of VMS-A1 V2.0.0.
Click Next to continue. You can also click HomePage to return to the homepage of the wizard, or click

Finished to exit.

Step 3: Importing Devices into Groups
The devices added can be organized into groups for a convenient management. You can get the live

view, play back the record files, and do some other operations of the devices through the group.

Device Management Group Managament Recora Schedula
CaAddgroup g Delete Group | Resources of Group Central
Search 2] & Import Modity Delste Remote Confi Filter
Hetnare < evce sena o
Encading Channel
Aarm input
2 S5 ICH-21
+ 1 ADVR 0B
+ O WR31R

20 INvR

IDH3IR

Previous HomePage Next Finished

Click Add Group to open the Add Group dialog box, input a group name as you want and click OK.
2. Click Import on Group Management interface, and then click the Encoding Channel tab to open

the Import Encoding Channel page.

Select the thumbnails/names of the encoding channels in the thumbnail/list view.

Select a group from the group list.

Click Import to import the selected encoding channels to the group.

You can also click Import All to import all the encoding channels to a selected group.

Note: Up to 64 cameras can be added to one group.

14
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M EncosingChannel |y Alam input
Select Devica a
Encoding Channel 3= e Group

sear 2
1921681134 @ £

Imgort
Add group
Group Name:
Create Group by Device Name
E
The following buttons are available on the Import Encoding Channel page:
e List View View the encoding channel in list view.
ala Thumbnail View View the encoding channel in thumbnail view.
57 Refresh Refresh the latest information of added encoding channels.
| Import Create a group by device name and import the device to group.

| e

Collapse/Expand Collapse/Expand the thumbnails of encoding channels.

Click Next to continue.

Step 4: Configuring the Record Schedule

The video files can be recorded on the HDDs, Net HDDs, SD/SDHC cards on the local device, or the
storage server connected.

Device Management Group Management Record Schodule
Camera Group Record Schedule Copyto... K save
Storage of Encoding Server
J CentrakEncoding Channel
¥ Record Schedule: Template 02 ~ Edit Atvanced Settings
I ICH-21-Encading Channel
i Capture Schedule Edil Advanced Settings
~| ADVR 08-Encoding Chan

= "2 WR-31IR-Encoding Cha.

# ' INVR-Encoding Channel

+ CJ IDH31IR-Encoding Chan...

Previous  HomePage Finished

Select the camera from the Camera Group list.
2. Check the checkbox Record Schedule to enable device local recording.

Select the record schedule template from the drop-down list.

15
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4. Click Advanced Settings to set the recording parameters.
5. Optionally, click Copy to... to copy the record schedule settings to other cameras.

6. Click Save to save the settings.

Step 5: Wizard finished.

The wizard is complete. Click Finished to close the wizard.

5.3 Menu Bar

Click the button on the upper-left side of the software ﬂto open the menu bar.

The Menu Bar contains following aspects

Menu Bar:

Search and view the captured pictures stored on
local PC.

Search and view the video files recorded on local
PC.

View the backup log files.

Exit the VMS-A1 client software.

Lock screen operations. Log in the client again to
unlock.

Switch the login user.

Import client configuration file from your
computer.

Export client configuration file to your computer.

=
@
0
&
>3

Display the window at size of 1024*768 pixels.

Display the window at size of 1280*1024 pixels.

Display the window at size of 1440*900 pixels.

Display the window at size of 1680*1050 pixels.

Display the window in full screen.

Open Main View page.

Open Remote Playback page.

Open E-map page.

Open Auxiliary Screen Preview window.

16
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Open the Device Management page.

Open the Event Management page.

Open the Record Schedule page.

Open the Account Management page.

Open the Log Search page.

Open the System Configuration page.

Select device to start broadcasting.

Set the arming status of devices.

Turn on/off the alarm output.

Open the player to play the video files.

Display the information of Email message to be

]
O

sent.

Open the guide for the client configuration.

Click to open the User Manual; you can also

open the User Manual by pressing F1 on your

keyboard.

View the basic information of the client

software.

Select the language for the client software and

reboot the software to activate the settings.

The function modules are easily accessed by selecting the function module from the View or Tool

menu.

You can check the information, including current user, network usage, CPU usage, memory usage and

time, in the upper-right corner of the main page.

5.4 Live View

Purpose:
You can view the live video of the added cameras on the Main View page. And some basic operations
are supported, including picture capturing, manual recording, PTZ control, etc.
Before you start:
17
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A camera group is required to be defined for live view.

Click View->Main View to open the Main View page.

Main View Page
1 View List
2 Camera List
3 PTZ Control Panel
4 Display Window of Live View

5 Live View Toolbar

Live View Toolbar:

— =

< o v =]

On the Main View page, the following toolbar buttons are available:

- . Set the screen layout mode and save the new settings for the
=D Set View . . _
current view; save the current view as another new view.

(™ Stop Live View Stop the live view of all cameras.
Previous Go for live view of the previous page.
Next Go for live view of the next page.
- Resume/Pause
’\ﬁ . Click to resume/pause the auto-switch in live view.
Auto-switch
@ Show /Hide the Menu  Show/Hide the config menu of auto-switch. Click again to hide.
& & Mute/Audio On Turn off/on the audio in live view
@ Full Screen Display the live view in full screen mode. Press ESC to exit.

Starting Live View for One Camera
Steps:
1. Open the Main View page.

2. Optionally, click the & icon in live view toolbar, then click the screen layout button D and

select the screen layout mode for live view.

18
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3. Click-and-drag the camera to the display window,
or double-click the camera name after selecting the display window to start the live view.

Note: You can click-and-drag the video of the camera in live view to another display window if needed.

Starting Live View for Camera Group
Steps:
1. Open the Main View page.
2. Click-and-drag the group to the display window,
or double-click the group name to start the live view.

Note: The display window number is self-adaptive to the camera number of the group.

Starting Live View in Default View Mode

Purpose:

The video of the added cameras can be displayed in different view modes. 4 frequently-used default

view modes are selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen.

Steps:

1. Open the Main View page.

2. Click theicon '*' to expand the default view list.

3. Click to select the default view mode, and the video of the added cameras will be displayed in a
sequence in the selected view.

Note: Right-click the current default view name on the list and click Save View As., and you can save

the default view as a custom view.

Starting Live View in Custom View Mode

Purpose:

The view mode can also be customized for the video live view.
Steps:

1. Open the Main View page.

2. Click theicon '*' to expand the custom view list.

3. Click New View in the custom view list to create a new view.
4

Input the view name and click Add. The new view is of 4-Screen mode by default.

5. Optionally, Click the ¥ icon in live view toolbar, then click the screen layout button E and

select the screen layout mode for the new view.
6. Click-and-drag the camera/group to the display window,

or double-click the camera/group name in custom view mode to start the live view.

7. Click the icon D to save the new view.

Stopping the Live View
Steps:
1. Select the display window.

2. Click the icon . that appears in the upper-right corner when the mouse pointer is over the
display window,

19
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or click Stop Live View on the right-click menu to stop the live view of the display window.

You can also click the button % in live view toolbar to stop all the live view.

5.5 Recording

Purpose:

Some local devices, including the DVRs, NVRs, and Network Cameras, provide storage devices such as
the HDDs, Net HDDs and SD/SDHC cards for record files.

Before you start:

The newly installed storage devices need to be formatted. Go to the remote configuration page of the
device, click Storage->General, select the HDD or SD/SDHC card, and click Format to initialize the

selected storage device.

Click Tool->Record Schedule to open the Record Schedule page.
Camera Group Record Schedule Copylo... Id save

Storage of Encoding Server

GantalEntoting Crannal
Record Schedule All-day Template v Edit Advanced Sefings
= 192168 11.34_P Ca

=i 192.159.11.34_JF Ca
=% 192 4581134 IP Ca

1 ICH-21-Encoding Channel
w= |CH-21_Cameral

1 ADVR 08-Encoding Chan
== ADVR 08_Cameraz
&= ADVR D8_Camera3
== ADVR D8_Camerad
== ADVR 08_Cameras
= ADVR 03_Cameras
== ALVR 0_Camera?

= ADVR 08_Camerag

Steps:

1. Open the Record Schedule page.

2. Select the camera from the Camera Group list.

3. Check the checkbox Record Schedule to enable device local recording.

4. Select the record schedule template from the drop-down list.
All-day Template: for all-day continuous recording.
Weekday Template: for working-hours continuous recording from 8:00 AM to 8:00 PM.
Alarm Template: for motion detection or alarm input triggered recording.
Template 01-08: fixed templates for specific schedules. You can edit the templates if needed.
Custom: can be customized as desired.
If you need to edit or customize the template, see Configuring Record Schedule Template.
Click Advanced Settings to set the recording parameters.
Optionally, click Copy to... to copy the record schedule settings to other channels.

Click Save to save the settings.

20
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Advanced Settings x

Pre-record: 55 v
Post-record: 55 v
Video Expired Time: 0 day(s)
Redundant Record: Mo v
Record Audio: Yes v

Descriptions

Normally used for the event triggered record, when you want to record before

the event happens

After the event finished, the video can also be recorded for a certain time.

The time for keeping the record files in the storage device, once exceeded, the

files will be deleted. The files will be saved permanently if the value is set as 0.

Save the video files not only in the R/W HDD but also in the redundant HDD.

Record the video files with audio or not.

Configuring Record Schedule Template

Perform the following steps to configure the record schedule template:

If Template 01-08 is selected from the drop-down list, start from step 1;

If Custom is selected from the drop-down list, start from step 2.

1.

Click Edit to enter the Templates Management interface. Select the template to be set and you
can edit the template name.
Set the time schedule for the selected template.
# Schedule Recording rofer to normal schedule record. The schedule time bar is greenyellow.
£ EventRecording ofers to the schedule record for the alarm input or motion detection event. The
schedule time bar is red.

£ Command | ofers to the schedule record triggered by command. The schedule time bar is
green.
Note: Record triggered by command is only available for the ATM transactions when the ATM DVR
is added to VMS-AL.

When the cursor turns to E, you can edit the schedule time bar.

When the cursor turns to E:E“'ﬂ you can move the selected time bar you just edited.
When the cursor turns to E you can lengthen or shorten the selected time bar.
Optionally, you can select the schedule time bar,

and then click the icon | ® | to delete the selected time bar,

or click the icon | B | to delete all the time bars,

or click the icon to copy the time bar settings to the other dates.

Click OK to save the settings.
21
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You can click Save as Schedule Template on the Custom Schedule interface, and then the custom

template can be saved as template 01--08.

Note: Up to 8 time periods can be set for each day in the record schedule.

Templates Management =
All-day Template £ Schedule Recording| £ EventRecording & Command | % 1
Weekday Templ...
0 2 4 £ 8 10 12 4 16 18 0 2 4
Mon
Event Template
1 2 4 [ [ 10 12 14 18 18 20 22 24
Template 01 Tue . . . .
Template 02 0 2 4 [ 8 10 12 14 16 18 20 22 24
Wed i 3 .
Template 03
0 2 4 & 8 10 12 4 16 18 0 2 24
Template 04 Hhil
0 2 4 [ 8 10 12 14 16 12 20 2 4
Template 05 Fri .
Template 06 o 2 1 [ 8 10 12 1 16 1 20 2 4
Sat - i ‘
Template 07
i 2 1 [ e 10 12 1 6 18 20 2 24
Template 08 Sun

5.6 Playback

Purpose:

The record files stored on the local device or the storage server can be searched by custom view,

camera or triggering event, and then can be played back remotely.

Click View->Remote Playback to open the Remote Playback page.

Camera
Event
Motion Detecton

Cenlral

= 102 168.1134_P

Szeged

ICH-21

Alarm Input

4 February b 2014
2—r M T W T F 8

RS
12 13 1415
19 20 21 2
5 25 27 28

3 Wore Search Options Vindawo:
Search
4-.—.a..rca Result

Remote Playback Page
1 View List, Camera List and Event List
2 Calendar
3 Search Options
4 Search Result List
5 Display Window of Playback

22
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6 Playback Toolbar

7 Timeline

5.6.1 Normal Playback

Purpose:

The record files can be searched by custom view or camera for the Normal Playback.

Searching Record Files for Normal Playback

Steps:

1. Open the Remote Playback page.

2. Click ® to expand the View List or Camera List on the left-side.

3. Select the view or camera to be searched from the list.

4. Select the day to be searched on the calendar.
You can also click * to show more search options, and then click the icon ﬂ to specify the
start time and end time for the search.

5. Click Search. The record files of the selected view or camera will be displayed on the Search Result

list. You can filter the results through the Filter text field.

Note: Up to 16 cameras can be searched simultaneously.

= ®= 192 168.11.34_IP Cameral
B 2014-02-22 11:56:49
B 2014-02-22 11:56:52
ﬁ 2014-02-22 11:56:54
B 2014-02-22 12:50:46
B 2014-02-22 12:53:32
B 2014-02-22 13:12:00
ﬁ 2014-02-2215:32:36

= ®= 192 168.11.80_Camerai
B 2014-02-22 145711
B 2014-02-22 15:31:46

+ == 192.168.11.80_Camera2

Normal Playback

After searching the record files for the normal playback, you can play back the record files in the

following two ways:

Playback by File List

Select the record file from the search result list, and then click the icon U in the toolbar,

or double-click the record file to play the video on the display window of playback.
Playback by Timeline
The timeline indicates the time duration for the record file, and the record files of different types

are color coded. Click on the timeline to play back the video of the specific time.

You can click == or | I to scale up or scale down the timeline bar.
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Youcanclick '€ or 2 to go to the previous or the next time period.

You can use the mouse wheel to zoom in or zoom out on the timeline.

02-22-2014 Szo 14:57:17

L=

Camera 0

s

windowd

Window02
Window03

Window04

Normal Playback Toolbar:

e €=
18 10 12 1w 2x e 8w g

On the Normal Playback page, the following toolbar buttons are available:

@ @ Async/Sync Playback Click to play back the record files synchronously/asynchronously.

- Stop Playback Stop the playback of all cameras.
@ l\;;_' Pause/Start Playback Pause/Start the playback of the record files.
<9 Single Frame Play back the record files frame by frame.
@ & Volume Click to turn on/off the audio and adjust the audio volume.
Full Screen Display the video playback in full screen mode. Press ESC to exit.

Note: You can move the slider on the Playback Speed Bar to set the playback speed.

5.6.2 Event Playback

Purpose:
The recordings triggered by motion detection or alarm input can be searched for Event Playback and

this function requires the support of the connected device.

Searching Record Files for Event Playback
Steps:
1. Open the Remote Playback page.

2. Click “ toexpand the Event List on the left-side.

3. Click Motion Detection or Alarm Input, and select the cameras or alarm input sensors.
4. Select the day to be searched on the calendar.

You can also click ¥ to show more search options, and then click the icon E/ to specify the
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start time and end time for the search.

5. Click Search. The recordings from the selected cameras and sensors triggered by motion detection

or alarm input will be displayed on the Search Result list.

Event Playback

After searching the recordings triggered by the event, you can play back the record files in the

following two ways:
® Playback by File List

Select the record file from the search result list, and then click the icon

or double-click the record file to play the video on the display window of playback.

® Playback by Timeline

in the toolbar,

The timeline indicates the time duration for the record file. Click on the timeline to play back the

video of the specific time.

Event Playback Toolbar:
On the Remote Playback page, the following toolbar buttons are available:
g Stop Playback Stop the playback of all channels.
w \} Pause/Start Playback Pause/Start the playback of record files.
Q Single Frame Play back the record files frame by frame.
Previous Event Go to the playback of the previous event.
Next Event Go to the playback of the next event.
@w Volume Click to turn on/off the audio and adjust the audio volume.
w Full Screen Display the video playback in full screen mode. Press ESC to exit.

You can move the slider on the Playback Speed Bar to set the playback speed.

5.6.3 Synchronous Playback

Purpose:

In synchronous playback, the record files can be played back in synchronization.

Note: Record files from up to 16 cameras can be played back simultaneously.

Synchronous Playback for Some Searched Cameras
Steps:

1. Start the normal playback of the searched cameras.

2. Click & in the toolbar, and then the record files in normal playback will be played in sync. The

icon L turns to W

3. To disable the synchronous playback, click the icon L3
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Synchronous Playback for All Searched Cameras
Steps:

1. Search the record files for the normal playback.

=
2. Click @ in the toolbar to enable the synchronous playback. The icon @ turns to .

3. Select the record file from the list and click <,

or click on the timeline to start the synchronous playback for all searched cameras.

4. To disable the synchronous playback, click the icon =,

GPRO1469

el (]|
e

=Nl < w0 0 we ww

Window02

5
WindowD'1 |
|
Windaw03 |

Window04

5.7 E-map

Purpose:

The E-map function gives a visual overview of the locations and distributions of the installed cameras

and alarm input devices. You can get the live view of the cameras on the map, and you will get a

notification message from the map when alarm is triggered.
Click View->E-map to open the E-map page.

26



Quick Start Guide of VMS-A1 V2.0.0

Search. 2]
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= 192.168.11.34_IP Cam
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E-map Page

1 Group List
2 Map Display Area
3 E-map Toolbar

5.7.1 Adding an E-map

Purpose:

An E-map needs to be added as the parent map for the hot spots and hot regions.
Steps:

Open the E-map page.

Select a group for which you want to add a map.

Input a descriptive name of the added map as desired.

Click theicon |~ and select a map file from the local path.

o ok w N PE

Click OK to save the settings.

Notes:

® The picture format of the map can only be *.png, *.jpg or *.bmp.
®  Only one map can be added to a group.

E-map Info x®

Map Name Essen
Path: C:UJsersiTamas/DocumentsiT... | =

Click the icon ?ﬁ in the Map Display Area to open the map adding dialog box.
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The map added is displayed in the Map Display Area. Use the mouse wheel to zoom in or zoom out on
the map. You can click-and-drag the yellow window in the lower-right corner or use the direction

buttons and zoom bar to adjust the map area for view.

admin  16:54:14 '@ = '8 %

B Essen « 3% > +
= 192.168.11 34_IP Cam
+ 20 Saaged
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Wb 2
STADTHEZIAKE!
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% M of
fer

geng A

8 ——
Pe =
5 o o Essen ettt ausen ® o el

OTBEZIRKE Il 35

9 @ ‘a ﬁ @ ,;"‘ wi : Search. )

Click the button Edit Map or Map Preview in the E-map toolbar to enter the map editing mode or
map preview mode.
E-map Toolbar in Map Editing Mode:

s rroven el AR o & B O 0 2

E-map Toolbar in Map Preview Mode:

— B C—

On the E-map page, the following toolbar buttons are available:

Add Alarm Input
Add Hot Region
Modify

Delete

Clear Alarm Info

LR EmeBE

Back to Parent Map

Modify Map Modify the map information, including the map name and file path.
Delete Map Delete the current map.
Add Camera Add a camera as the hot spot on the map.

Add an alarm input sensor as the hot spot on the map.

Add a map as the hot region on the current map.

Modify the information of the selected hot spot or hot region.
Delete the selected hot spot or hot region.

Clear the alarm information displayed on the map.

Go back to the parent map.

5.7.2 Hot Spot Function

Purpose:
The cameras and alarm inputs can be added on the map and are called the hot spots. The hot spots

show the locations of the cameras and alarm inputs, and you can also get the live view and alarm
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information of the surveillance scenarios through the hot spots.

Adding Hot Spots
Adding Cameras as Hot Spots

Steps:

1.

2
3
4.
5

Click the Edit Map button in the E-map toolbar to enter the map editing mode.

Click the icon ‘€ in the toolbar to open the Add Hot Spot dialog box.

Check the checkboxes to select the cameras to be added.

Optionally, you can edit hot spot name, select the name color and select the hot spot icon.
Click OK to save the settings.

You can also click-and-drag the camera icons from the group list to the map directly to add the hot
spots.

Add Hot Spot x
+ Linked Camera Hotspot Name Hotspot Color  Hot Spot lcon

|
[+ 182.168.11.34_IP Came... 192168.11.34_IPCam_. [ Green - &

Il Green
| White
B Red
Yellow
o Gray
B sue
W Back
Adding Alarm Inputs as Hot Spots
Steps:
1.

N

Click the Edit Map button in the E-map toolbar to enter the map editing mode.

Click the icon (9 in the toolbar to open the Add Hot Spot dialog box.

Check the checkboxes to select the alarm inputs to be added.

Optionally, you can edit hot spot name, select the name color and select the hot spot icon.
Click OK to save the settings.

You can also click-and-drag the alarm input icons from the alarm input list to the map directly to
add the hot spot.

= LinkedAlarm Input Hotspot Name Hotspot Color Hot Spot Icon
192,168 11.80_A2 192.168.11.80_A2 W Green B
182.168.11.80_A3 192.168.11.80_A3 W Green B

(4 192.168.11.80_Ad 192.168.11.80_Ad 8 Green| <| B

B Black
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Modifying Hot Spots

You can modify the information of the added hot spots on the map, including the name, the color, the
icon, etc.

Steps:

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.

2. Select the hot spot icon on the map and then click & in the toolbar,

or double-click the hot spot icon on the map to open the Modify Hot Spot dialog box.
3. You can edit the hot spot name in the text field and select the color, the icon and the linked
camera or alarm input.

4. Click OK to save the new settings.

To delete the hot spot, select the hot spot icon and click v in the toolbar.

Modify hat spot # Hodify hot spot x

Hot spot name: 192.168.11.34_IP Cameral Hot spot name: 192.168.11.30_A4
Linked Camera: Linked Alarm Input

~ 192.168.11.34_IP Cameral 192 168.11.80_A2
192 168.1180_A3

+ 192168 11.80_A4

Hotspot Color: |l Green |~ Hotspotlcon: (@ ~ Hotspot Color; [l Green ~ Hotspoticon: @ |~

Previewing Hot Spots
Steps:
1. Click the Map Preview button in the E-map toolbar to enter the map preview mode.

2. Double-click the camera hot spots, and you can get the live view of the cameras.

3. If there is any alarm triggered, an icon A will appear and twinkle near the hot spot. Click the

alarm icon, and then you can check the alarm information, including alarm type and triggering
time.
Note: To display the alarm information on the map, the Alarm on E-map functionality needs to be set

as the alarm linkage action.
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5.7.3 Hot Region Function

Purpose:

The hot region function links a map to another map. When you add a map to another map as a hot

region, an icon of the link to the added map is shown on the main map. The added map is called child

map while the map to which you add the hot region is the parent map.
Note: A map can only be added as the hot region for one time.

Adding Hot Regions
Before you start:
Add another map to the group.

Steps:

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.

2. Select an added map as the parent map.

3. Click theicon & in the toolbar to open the Add Hot Region dialog box.

4. Check the checkbox to select the child map to be linked.

5. Optionally, you can edit the hot region name, and select the hot region color and icon.

6. Click OK to save the settings. The child map icons are added on the parent map as the hot regions.

You can click-and-drag the child map icons to move the hot regions to the desired locations.
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Add Hot Region x

« Linked Map HotRegion Name HotRegion ... Hot Region lcon
 Map 2 Map 2 |l Green - W@

Modifying Hot Regions

Purpose:

You can modify the information of the hot regions on the parent map, including the name, the color,

the icon, etc.

Steps:

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.

2. Select the hot region icon on the parent map and then click &7 inthe toolbar,
or double-click the hot region icon to open the Modify Hot Region dialog box.

3. You can edit the hot region name in the text field and select the color, the icon and the linked
child map.

4. Click OK to save the new settings.

To delete the hot region, select the hot region icon and click % in the toolbar.

Modify Hot Region x

Hot Region Name Map 2
Linked Map:

~ Map2

HotRegion Color [l Green v HotRegion lcon: 8§ [«

[ox I cance

Previewing Hot Regions
Steps:

1.

2
3.
4

Click the Map Preview button in the E-map toolbar to enter the map preview mode.
Click the hot region icon to go to the linked child map.

The hot spots can also be added on the hot regions.

You can click the icon &3 in the toolbar to go back to the parent map.

You can also click the icon . in the toolbar to clear the alarm information.
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6. Exit System

Click File on the top menu and select Exit, or click L% on the upper-right corner of the main interface,
and then a confirmation dialog pops up. Click OK to exit VMS-A1.
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